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INTRODUCTION 

SYSTEM DESCRIPTION 
CART (Combat Analysis and Review Toolkit) is a MTWS (MAGTF Tactical Warfare 
Simulation) after action reporting system. CART allows the user to analyze data from an 
exercise using both a display (i.e., pictorial) and reports. 
 
CART is intended to be a tool for analysts to analyze, document and present exercise data 
to interested parties during or after an exercise is completed. This is in response to a US 
Marine Corps requirement for a system to analyze exercise data for the purposes of 
producing an effective exercise debrief, capturing required data, and assessing the results 
of the actions taken during the exercise. 

OVERVIEW 
 
CART consists of a server and one or more client stations as noted in the MTWS System 
Architecture diagram included below. The CART server receives the current exercise 
data from the MSC (Model System Control) server and stores it in the CART active 
database. The CART client(s) can access, filter and document this data. The CART 
client(s) can then present this data visually using the tactical display and textually using 
the report generator. 
 

C4I
Systems

CART Client
1 or more

KEY
MSC:  Model System Control
MAN: Model Application Network
CART: Combat Analysis Review Toolkit
MDS:  Model Display Station 
C4I: Command, Control, Communications, Computers, & 
Intelligence

MDS
1 or more

MSC

MTWS SYSTEM ARCHITECTURE

CART Server

MAN

 
 
When a new exercise scenario is started on MTWS, the previous exercise that was 
captured on the CART server is archived in the CART server exercise directory. 
Exercises that have been saved on the CART server can be replayed independently from 
the main MTWS system. Basic CART Client operating procedures are available in 
Chapter 2 of this manual. 
 
The CART server is a typical PC workstation configured with the Linux O/S. The CART 
Client(s) is also a typical PC workstation configured with Windows 2000, Microsoft 
Office 2000 and Maui software that enables the PC workstation to operate either as an 
MDS (Model Display System) or a CART Client. 
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The CART Client consists of two primary parts, the Report Generator and the Tactical 
Display. The CART Report Generator provides information in a textual format. The 
CART Tactical Display visually depicts exercise data in accordance with the object filter 
settings that can be manipulated by the user. The content of the reports is coupled with 
the data shown on the display, generally, only objects that are shown on the display are 
reported on. Details of the behavior of individual reports are described later in this 
document 
 
The CART Report Generator provides reports of user selected data for selected periods of 
time. The user can access the data in the server and format reports on the Client to 
provide information on various aspects of the exercise. These reports can be used to 
document and present information required for exercise adjudication and analysis. 
 

 
 



The MTWS Documentation Suite – Volume 5 
MTWS Exercise Analysis 

 

3 

The CART Tactical Display visually displays units and exercise objects and can display 
these over selected time periods. The CART Tactical Display also allows the user to 
filter/select units and other exercise objects for presentation. 
 
The display and reporting of the CART data can be shown over any selected time period 
between the start and end of the exercise. The exercise data can be ran forward and 
backward in time, using the manual step or auto play buttons located on the CART Client 
tool bar, to provide a visual and/or textual representation of selected data for that time 
period of the exercise. 
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CART CLIENT BASIC OPERATING PROCEDURES 

SYSTEM START-UP FOR “ACTIVE” EXERCISE 
The System Administrator will load and initialize the MTWS exercise before starting the 
CART Server and placing the system into run. Detailed MTWS and CART Server start –
up instructions are located in Volume 4 of the MTWS Documentation Suite. Once CART 
is started and MTWS has run for at least (1) minute the System Administrator will click 
on the Reload (Refresh) button on the Mozilla toolbar, note that the exercise is connected 
and that the Exercise Name & Start Time are listed in the Exercise Status Report.  
 
The CART Server now has the initial database from the MSC and Client operator(s) will 
be notified that they can start their CART Client and display the initial database. As the 
CART Server receives updates at one-minute intervals from the MSC, the CART clients 
will follow slightly behind the CART Server exercise time. 
 

CART CLIENT START-UP 
 
With the workstation logged on and the normal windows display available, an Internet  
Explorer CART Reports icon and a CART icon should be visible on the desktop. If they 
are not present, see your system administrator. If they are present, continue as follows: 
 

 
 
Click on the Internet Explorer CART Reports icon. Then click on the Exercise Status 
under Exercise Summaries at the end of the Reports section. Ensure that the CART server 
is connected and the Exercise Name & Start Time are listed. 
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Iconify the CART Reports window and click on the CART icon. 
The CART Splash screen window will appear. 
A Warning may appear if there is less than a complete minute of data available for the 
exercise in the CART server. Click YES to continue and the CART display will come up-
--note that the “Disconnected” button on the CART display is red, verifying no 
connectivity to the CART server. 

 
 

 
Set up CART display profile as desired (font size, maps, object filters, etc)  
Click on the red “Disconnected” button to connect; button should turn green and read 
“Connected”. 
 

 

CART CLIENT START-UP FOR “HISTORIC” EXERCISE 
 
System Administrator will ensure that the CART server is not connected and that CART 
is not running on the MSC. Then on the CART Server Manage Exercise Window verify 
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that the desired Historic exercise is in the “Active “mode. At this point the CART Clients 
can be started, as depicted in Section 2 above, and when connected the Client will load 
and display the selected exercise. 
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CART TACTICAL DISPLAY 
 
The tactical display provides a means for the user to filter and graphically display units 
and exercise objects. To start the CART Tactical Display, double click on the CART icon 
on the desktop. Upon start up the tactical display will appear and various menu bar 
selections are provided. These are the same as those in the MTWS display station with 
the exception of some of the options in the “Display Objects” menu that have additional 
features, and the Maui Command Center Menu which is not present. The toolbar provides 
the user the capability to set time periods and to move forward and back in time. 
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EXERCISE REPLAY 
 
CART Tool Bar 
 
The CART Tool Bar provides the user with the capability to set time periods for the 
presentation of data from the CART server. The tool bar also allows the user to move 
forward or backward in time. 
 

 
 
Start Time (DTG). This time is the start time of the time period to be displayed on the 
CART tactical display and reported on by the CART Report Generator. 
 
End Time (DTG). This is the end time of the time period to be displayed on the CART 
tactical display and reported on by the CART Report Generator. 
 
Note: Only data between the Start Time and End Time entered here is displayed on the 
CART map display. The Start Time and End Time must be a valid exercise time. 
 
The display of symbols such as ground units, ships and air missions is based on what the 
values were at the end time shown in the CART tool bar. The history trail for units, ships, 
submarines, ship-to-shore objects and air-missions is displayed for the time range 
between start time and end time. 
 
Objects and events that exist for only a limited time period such as fire missions or 
ground detections are shown if they existed at any point during the displayed time period.  
 
Step (Forward/Back). This allows the user to “step” forward or backward in time 
intervals (as entered in “Time Step”). 
 
Replay Rate. This applies only in the “Autoplay” mode and is the time in seconds 
between Time Steps in the Autoplay mode. Example: As set above: Replay Rate= 60 and 
Time Step= 5 means that if Autoplay is selected CART will advance five minutes of 
exercise time every 60 seconds of real time. 
 
Time Step. This is the time interval in minutes at which CART will step forward or 
backward. This is applicable in either the Manual or Autoplay modes. 
 
Autoplay. If this feature is selected CART will automatically step forward or back in 
time intervals as set in “Time Step” at the rate set in “Replay Rate”. When CART is 
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advancing and End Time has reached the point where it is within one minute of the 
current exercise time, CART will advance at one-minute intervals and remain one minute 
behind the current exercise time. 
 
Connected. Gives the status of the CART client (i.e., the CART client is connected or 
not connected to the CART server. 

OBJECT FILTERS 
 
Filters are used in CART to remove objects from the display that are not of interest to the 
current analysis and to control which features of an object are displayed. 
 
The CART reports also use the Object Filters to control which objects are reported on. 
Thus objects that are filtered off are, in general, not reported on. 
 
Filters act cumulatively. For example if the Environment panel is set to show only LF 
objects and the Object Groups panel is set to show only Ground objects, the display will 
show only LF Ground objects. AG Air objects, AG Ground objects and LF Air objects 
will not be shown. 
 
If an object is removed from display by one filter, no combination of other filters will 
cause it to be added back on to the display. 
 
To open the Filters panel select “Display Objects –> Object Filters” from the Map 
Display menus or click the filter icon on the menu bar:  
 

 
 
Some filter settings are applied to values that can change over time. In such instances the 
filters are reapplied every time the displayed time range is changed. For instance, if in the 
direction filter, the filters are set to display moving units, but not to display non-moving 
units, when stepping forward, a unit that transitions from stationary to moving, will 
appear on the display. When it stops moving, it will be removed. Stepping backward in 
time will reverse the process. 
 
Universal Functions for Filter Panel 
 
Every filter panel includes the four following controls located at the panel bottom. 
 

?? Restore  allows the user to return to the Default Settings (i.e., all filters are 
removed, meaning that all simulation objects will be displayed), or any saved 
filter profiles. The filter settings that were in effect when the workstation was 
started are stored using the machine name as the identifier. You can also save a 
current setup by defining a profile name from the Tools->Profile manager menu 
item and then selecting Tools->Save Profile from the menu. 
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?? Apply All: allows the user to apply all changes on all panels. Changes made to 
the filters do not take affect until they are applied. Note that all panels with 
settings that have not been applied are shown in the left filter panel in red. All 
other panels are shown in black.  

 
?? OK: allows the user to quit the filters window and apply the effects of all filters. 

 
?? Cancel: allows the user to close the filters window without applying any changes. 

The settings when filters were last applied will remain in effect. All changes to 
panels whose title is shown in red in the left window will be lost. 

 
In addition the following two buttons are positioned above the previous four buttons and 
affect only the current changes. 
 

?? Apply: Apply the settings on the current window. 
 
?? Cancel: Cancel the settings on the current window and restore the previously 

applied settings to the panel display. 
 
CART includes all the filters that are available in the Maui Workstation. The following 
sections will present those filters, which are unique to the CART client station. 
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GENERAL FILTERS 

 
 

Geographical Area. 
Geographical area is used to set up a “box” to display exercise units and objects. 
Selecting the Upper left and Lower right corners of the desired box do this. Clicking on 
the desired location on the display or typing the desired LAT/LONG in the field can enter 
these. The format for a LAT/LONG location is XX:XX:XXL,XXX:XX:XXL where X is 
a number in the range 0-9 and L is a letter, ‘N’ or ‘S’ for the latitude, and ‘E’ or ‘W’ for 
the longitude. A box can also be defined using the cursor to define the box and clicking 
“Apply”. 
 
Units and exercise objects within the geographical box will be displayed while those 
outside its boundaries will not. Example: A firing unit outside the box firing into the box 
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will not be displayed but the fire mission will. A firing unit inside the box firing outside 
the box will be displayed while the fire mission will not be displayed. A firing unit inside 
the box firing inside the box will be displayed and its fire mission will also be displayed. 
 

 
 
If “Display Bounding Box” is selected the boundaries of the selected geographical area 
will be displayed when “Apply” is clicked. To remove the display of the area deselect 
“Display Bounding Box” and click on “Apply”.  
 
To remove the geographical area, deselect “Filter by Geographical Area” and click on 
“Apply”. 
 
History. 
History is used to show the movement trails of air missions, STS elements, submarine 
and units. If this is selected the movement tracks of the selected air missions, STS 
elements and units will be shown for the time period entered. 
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The history trails of the objects are shown as thin trails shown in the color of the objects 
side (e.g. blue for LF objects, red for AG objects). The line joins together points that the 
object has traveled through during the displayed time period. 
 
For Unit objects, a dotted trail object identifies a period of travel during which it was 
transported by another unit, air mission, ship, or STS element. A solid line identifies a 
period in which an object moved using it’s own assets. 
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Object Name.  
 
The Object Name filter allows objects to be filtered individually. 
 

 
 
To filter one or more named objects, check the box titled “Show Only Selected Objects”, 
then select objects using one of the following methods: 
 

?? Select the object type from the selection box titled “Type”, e.g. Unit. Type in the 
name of an object into the “Name” field. Press the “+” button. This sequence may 
be repeated as many times as desired. 

 
?? Draw a bounding box on the map display surrounding the objects to be selected 

by left-clicking the mouse in the center and the dragging the mouse to the outside 
corner of the area to be selected. 

 
?? Clicking directly on the object to be selected. 

 
Click “Apply” to update the map display with the changes. 
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To remove some of the units from the list click on one or more objects (either by 
dragging the mouse across a range of items, or by holding down the “CTRL” key on the 
keyboard and clicking on the objects to be removed) then click the “Remove Selected” 
button. 
 
Click on the “Remove All” button to remove all units in the list. 
 
In the example below only airfields 2FARP and 3FARP have been selected (i.e., nothing 
else is shown). 
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GROUND 
Radar Orientation. 
This panel provides the facility filter ground radars by their current azimuth. Only radars 
with an azimuth between the minimum and maximum values (inclusive) shown on the 
filter panel will be displayed. 
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Radar Types. 
This filter allows the user to select the type(s) of radar for display and reporting. Uncheck 
the boxes to remove the display of CFR (Counter Fire Radars), GSR (Ground 
Surveillance Radars), and PAR (Pulse Activated Radars). 
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UNITS 
 
Combat Effectiveness. 
This filter permits filtering of ground units within a range of combat powers. Units with a 
combat effectiveness value from the minimum to the maximum values will be displayed 
or reported on. The shown numbers are inclusive. Using the sliding bars or typing the 
values directly into the text boxes controls the minimum and maximum values of combat 
effectiveness used for filtering ground units. 
 
When the maximum combat effectiveness is set to 100, Units with a combat effectiveness 
of 100 or greater will be displayed. 
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Detection Status. 
This filter permits filtering of units based on whether or not they have been detected. (i.e., 
if “Detected” is selected only units that have been detected will be displayed; if “Not 
Detected” is selected only units which have not been detected will be displayed;  if both 
are selected all units will be displayed; if neither is selected no ground units will be 
shown). 
 
A unit is considered detected if it was detected any time between the Start Time and End 
Time shown on the CART tool bar at the top of the map display window. 
 
This filter affects only ground units and units of all sides are filtered, regardless of 
settings in the Environment filter panel, or whether the ground detections themselves are 
being shown. 
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Direction. 
With this filter, the user can filter units by their direction of movement or facing and 
whether the units are moving or not. In the example below only units moving with a 
direction of movement between 90 and 180 degrees would be displayed. 
 
For the purposes of this filter, a unit is considered to be moving only if it is moving at the 
end time displayed on the CART tool bar and the direction used for filtering is the 
direction the unit is facing or heading at the end time. 
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Display Data. 
This filter is almost the same as that used in Maui. The unique feature for CART is 
“Weapon Range” which if selected causes the display of a range ring for the primary 
weapon  for each of the following units: 
 
Artillery 
Mortar Units 
Naval Gun Fire 
 
The range ring shows the maximum range of the indirect weapon with the largest range 
from the units asset list at the exercise start or when the unit was initialized if the unit was 
defined after exercise start. These values are set in the Parametric Data. The range shown 
does not take account of whether the asset has ammunition or is functional nor does it 
account for environmental factors such as terrain or weather.  
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Echelon Level.  
This filter allows the user to select a particular echelon or echelons for display. In the 
example below only units defined as a battalion, a squadron, a company or a battery 
would be displayed. All units not so defined would not be displayed or reported on. 
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Engagement status. 
If this feature is selected only units with the correct status will be displayed or reported 
on (i.e., if “Engaged” is selected only engaged units will be displayed, if “Not Engaged” 
is selected only units which are not engaged will be displayed, and if both are selected all 
units will be displayed). In the example below only units in active ground engagements 
(i.e., direct fire engagements) will be displayed. 
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Firing Units.  
If this is selected the only fire missions to be displayed will be those of units entered into 
the panel by their Unit ID. 
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Posture.  
This filter allows the user to filter the display of units by their posture. One or more 
postures may be selected and only units with a selected posture will be displayed or 
reported on. 
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Roll Up. 
This filter allows the display of a unit and all subordinates (those reporting directly and 
indirectly)  
 

 
 
To filter one or more headquarters units and their subordinates, check the box titled 
“Show Subordinates of Selected Objects”, then select units using one of the following 
methods: 
 

?? Type in the name of a unit into the “Name” field. Press the “+” button. This 
sequence may be repeated as many times as desired. 

 
?? Draw a bounding box on the map display surrounding the units to be selected by 

left-clicking the mouse in the center and the dragging the mouse to the outside 
corner of the area to be selected. 

 
?? Clicking directly on the unit to be selected. 

 
Click “Apply” to update the map display with the changes. 
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When a headquarters unit is added to the list any of its subordinates are automatically 
removed. If an attempt is made to add a unit whose headquarters is already in the unit 
will not be added. 
 
To remove some of the units from the list click on one or more objects (either by 
dragging the mouse across a range of items, or by holding down the “CTRL” key on the 
keyboard and clicking on the objects to be removed) then click the “Remove Selected” 
button. 
 
Click on the “Remove All” button to remove all units in the list. 
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CART REPORT GENERATOR 
 
To start the CART Report Generator, double click on the CART Reports icon. Upon start 
up the Reports Menu will appear and various menu selections are provided. These 
selections allow the user to access the individual CART reports to provide textual outputs 
of desired information. 
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GENERAL FEATURES 
 
Overview of using Internet Explorer. 
 
The CART Reports are available through Microsoft Internet Explorer. This is the same 
software that most people use for browsing the Internet if you are familiar with this 
already you may choose to skip this section. 
 
Navigations.  
 
The Internet is composed of hypertext pages. These pages typically contain links to one 
or more other related pages. The link typically consists of a text description that you see 
on the page, and the address of another document that contains related information. 
Clicking on the link causes a “navigation” to the related page indicated by the link. 
 
CART reports work using this framework. The system is centered on a menu that 
provides access to reports for the various functional areas that CART supports. The 
functional areas are listed in alphabetical order. Links to the reports are shown in blue 
underlined text (if the linked to document has not previously been visited) or purple 
underlined text (if the linked to document has been previously visited) and have titles 
such as “Ground Unit” and “Spot Reports”. Clicking on the reports title will cause a 
navigation to the report. 
 
Internet explorer provides the following button bar by default. 
 

 
 
If this button bar is not available, it may be turned on my selecting: View->Toolbars-
>Standard Buttons. Note that these features are customizable and the setup at your site 
may vary slightly. From left to right the buttons have the following functions: 
 

?? Back: As you navigate through documents, Internet Explorer builds a list of the 
pages that you view. The back button allows you to iterate back through 
previously viewed pages. 

?? Back History: (the small black triangle between the arrows) Pull up a list of the 
titles of up to the last 9 pages visited, any of which may be navigated to by 
clicking on the page title.  

?? Forward: If you have already navigated backwards then the forward button takes 
you to the pages visited after the first viewing of the current page. 

?? Forward History: The forward history allows viewing the titles of up to 9 pages 
that you have already stepped backwards over. Any of the titles may be clicked on 
to view the original page again. 
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?? Stop: Interrupt the loading of a page. Note that some reports in CART may take 
minutes to load. If you interrupt a page loading, you may be able to select a 
smaller set of items in the report by changing the filters, and obtain the 
information you were looking for more quickly. 

?? Refresh: Force the page to reload. This will send a request back to the CART 
server causing the contents of the page to be re-evaluated. This resulting report 
may differ from the previous report, if the times or filters for the Map Display 
have been updated. See below for more information on the specifics of CART 
reports. 

?? Home: Navigate to the ‘home’ page. See “setting home button” below. 

?? Search: This feature has no utility in CART. 

?? Favorites: Allows the display of previously defined links. Can be used to 
generate report templates or “search sets” that can provide quicker information to 
report contents. See “Defining a report template” below. 

?? History: Allows access to previously viewed reports. In general Internet Explorer 
shows the report exactly as it was when first viewed, and does not automatically 
update the contents to reflect more recent changes. 

?? Mail: This feature has no utility in CART. 

?? Print: Directly print the displayed report to the currently defined printer. 

Setting font sizes. 
 
To change the size of text used in the report select “View->Text Size->”. We recommend 
selecting the smallest size that you can comfortably read. 
 
Searching for items in a report. 
 
Internet Explorer allows searching for a specific item on a page.  
 
To search for a specific item in a report, select the Edit->Find menu or type CTRL-F. 
Type the text to be searched for into the text box. And click the “Find Next” button. 
Continue clicking “Find Next” to find additional occurrences. 
 
This can be useful for identifying specific items in a report. For instance to identify the 
immediate subordinates of a unit ‘1MAR’: 

?? Run the ground units report displaying the fields Name and Higher HQ;  
?? Search the report by typing CTRL-F and typing ‘1MAR’ into the text field; 
?? Click the “Find Next” button to scan the report finding the subordinates of 

1MAR.  
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CART FEATURES 
 
Use of CART filters/report filters. 
 
Almost all CART reports share the same format as that shown below: 
 

 
 
Below the report title are the Report Filters. The filters can be used to limit the number of 
items that are included in the report. Below the Report Filters is a single selection box 
showing the Report Fields. The report fields define which pieces of information are 
shown for each item that is reported on. Next to the Report Fields is the go button. After 
selecting the desired Report Filters and Report Fields, clicking on the Go button 
generates the report. Note that the filters offer only the options that are currently valid. 
For instance a “Hierarchy” filter for ground units in a small exercise, might offer only 
Section, Platoon, Company, Battery, Battalion and Regiment, indicating that no units of 
size Corps, Division or Brigade are currently defined in the exercise. 
 
When setting filters, all, none or any combination of the filter boxes may be used. For 
any Report Filter, the report will include only the filter items that are selected. In each 
Report Filter multiple items may be selected by holding down the CTRL key and clicking 
on the items in the selection box. 
 
A special case for the Report Filter is if no items are selected. In this case, the filter is not 
activated, and no filtering for the field is applied to the report. 
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In the above example, the report is requesting all Cargos originating from the unit 3LHD. 
The fields Cargo ID, Destination Unit and Contents are all to be shown. The outputs of 
the report are shown below. 
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Note that once a report has been run, the filters are shown at the bottom of the report and 
the settings that were used to generate the report remain selected. These settings may be 
adjusted and then report rerun by clicking on the “GO” button again. 
 
In general, the CART reports use the filter settings and time settings that are in effect on 
the Map Display, in addition to the settings of the Report Filters. For instance, ground 
units that are filtered off using the map filters, are also filtered out of the CART reports. 
As a result the Map filters and report filters can be used in combination to narrow down 
the number of items that appear in a report. See below for an example of how to do this. 
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Report Time 
 
Reports, in general, are time specific, and use the times defined on the CART map 
window and referred to in this sections as the “report period”. Each report contains a 
summary box at the bottom as shown below: 
 

 
 
For instance, the Cargos report (shown above) shows the contents of each cargo at the 
end time of the report time period. Rerunning this report at a later point in the exercise 
will show different results if, for instance, the cargos are delivered to the destination 
units. 
 
Defining a report template 
 
In cases where the same report settings are used regularly, Internet Explorers’ Favorites 
can be used to save the settings, to save some time. For instance to print two reports 
showing the combat effectiveness and location, one showing HQ1/1 and all it’s 
subordinates, and another showing HQ2/1 and all its subordinates, each hour through the 
course of an exercise. One approach would be as follows: 
 

?? In the map display filters, select the roll-up panel, enter ‘HQ1/1’ into the text 
field, and press “Apply”. 

?? In the reports, select the “Ground Units” report by clicking on the shortcut button 
“Ground 

?? Select all units in the “Name” filter. In the fields report select the fields Name, 
Location, and Combat Effectiveness 

?? Hit “Go”. 
?? Click on the “Favorites” icon, or select Favorites->Add to Favorites … 
?? In the Name field enter HQ1-1 roll-up. Click on the “Links” folder in the box 

titled “Create in”. 
?? Check that a new button appears on the Links Toolbar with the title “HQ1-1”. If 

your links bar is not visible use View->Toolbars->Links to turn it on. 
?? Repeat the above steps for HQ2/1. 
?? Then from the CART Map Window set the step size to 60, and press the forward 

step icon. 
?? Run the HQ1/1 report by clicking on the first of the newly created buttons. Run 

the HQ2/1 rollup report by clicking on the other newly created button. 
?? Repeat the above two steps through to the end of the exercise. 
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REPORT SHORTCUT BUTTONS 
 

 
 

SHORTCUT BUTTON FUNCTIONS 
 
Home. Selection of this button will return the user to the CART Reports menu. 
 
Air Mission. This report lists all air missions in the database. The report can be filtered 
by aircraft (type), mission (type), side and squadron. The report fields are side, location, 
heading, speed, status, squadron, aircraft, mission, number of aircraft, takeoff time and 
ordnance. 
 
CDA. This shortcut gives access to CDA assessments in the database and can be filtered 
by event kind (air mission, fire mission or ground engagement), attacking unit/mission, 
damaged unit, weapon, ammo (type) and damaged asset. 
 
Fire Mission. This report provides a listing of all fire missions in the database. The 
report can be filtered by (fire mission) ID, target kind, firing unit, target name, firing side, 
firing weapon and projectile (type). 
 
Ground. This button gives the user access to the “Ground Unit” report, which can be 
filtered by side, unit type, hierarchy and/or controller. Valid report fields are name, side, 
controller, located at, hierarchy, unit type, speed, heading, mission, and posture. 
 
Intelligence. This shortcut allows the user to access the Ground Detection Selection 
Form which allows the user access to ground detections in the database. Detecting unit, 
detecting side, detected unit, detected side and method of detection can filter the report on 
ground detections. 
 
Assets . This is a shortcut to obtain a report of all the assets in the exercise database. 
Double-clicking on an asset (“155MM-HE”) will create a report listing all units with that 
asset and the quantity of the asset held by that unit(s). 
 
Spot Reports. This button provides a shortcut to the Spot Report Selection Form (type). 
This provides access to all spot reports in the database. Message type, unit mission and 
controller can filter the report. 
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MAIN MENU 

 
 
The CART Main Menu lists each of the major reports that are available in the CART 
system. The reports are listed alphabetically by functional area. The details for each 
report are described below. Unless noted otherwise, all reports described below are 
available from this web page. 
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AIR MISSIONS 
 
Air Mission 
This report provides general information on all types of air missions. The available filters 
are aircraft (type), mission (type), side and squadron. The report fields are side, location, 
heading, speed, status, squadron, aircraft, mission, number of aircraft, takeoff time and 
ordnance. Air missions that are filtered off in the CART map display are not shown in 
this report. Air missions that landed (or were destroyed) before the reporting period, or 
took off after the reporting period are also not reported. 
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Air Mission Damage 
 
This report lists the CDA inflicted by air missions on ground targets. Only 
“ARM_RECON”, “ASW”, “CAS”, “CIFS” and “DAS” missions are listed in this report. 
The available report filters are (air) mission ID, mission (type), number of aircraft and 
aircraft (type). The report fields are ID, side, status, aircraft (type), mission (type), 
number of aircraft, target location(s), attack time, attack altitude, ordnance used, damaged 
unit, asset and damage. 
 
As with the Air Mission report, air missions that are filtered off in the CART map display 
are not shown in this report. Air missions that landed (or were destroyed) before the 
reporting period, or took off after the reporting period are also not reported. 
 
This report shows all damage for the air mission, including damage that may currently be 
outside the time range of the current report. 
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Air Missions Which Caused No Damage 
 
This report is a listing of current air missions that caused no damage. The report shows 
“CAS”, “CIFS” and “DAS” air missions with a defined target that inflicted no damage or 
casualties. 
 
As with the Air Mission report, air missions that are filtered off in the CART map display 
are not shown in this report. Air missions that landed (or were destroyed) before the 
reporting period, or took off after the reporting period are also not reported. 
 
The report can be filtered by aircraft (type), mission (type), side and squadron and reports 
the side, squadron, target, mission (type), (air mission) status, aircraft (type), number of 
aircraft and ordnance (type). 
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Surface-to-Air and Air-to-Air Attacks On Aircraft. 
 
This report identifies air-to-air and surface-to-air engagements. The report fields include 
start (time), shooter (ID of engaging unit), target, event, weapon, ammo (type), damaged 
asset and K-Kill (damage to asset). 
 
As with the Air Mission report, air missions that are filtered off in the CART map display 
are not shown in this report. Air missions that landed (or were destroyed) before the 
reporting period, or took off after the reporting period are also not reported. 
 
The report shows only damage to air missions that occurred during the report period. 
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CDA. 
 
Combat Damage Assessment  
 
This shortcut gives access to CDA assessments in the database and can be filtered by 
event kind (air mission, fire mission or ground engagement), attacking unit/mission, 
damaged unit, weapon, ammo (type) and damaged asset. 
 
In this report, simulation objects that are filtered off in the CART map display do not 
show the damage they inflicted.  
 
The report shows only damage that occurred during the report period. 
 
The CDA report can be used to generate reports similar to the “Air Mission Damage” 
report and the “Fire Mission” report. However the CDA report facilitates searching for 
occurrences of particular assets that are damaged and particular units that are damaged. 
 
Note that number of rounds shown, is the number of rounds in a “volley”. This is based 
upon the way MTWS simulates combat. As a single volley can damage more than a 
single unit and more than a single type of asset, the same volley may be listed multiple 
times in the same report. For this reason, adding up the number of rounds, does not 
provide the number of rounds fired, by a unit or mission; typically it is many times larger. 
The Fire Mission report or Air Mission report will show the actual number of rounds 
fired by a mission. Ammunition expended in ground combat can be shown in the Unit 
Asset History reports. 
 
The CDA report shows changes to the assets of a Unit, thus it is possible to see an entry 
that shows negative quantities of M-kills or F-kills, or negative quantities of WIAs. This 
happens when a CDA event inflicts, say a M-kill on an asset, a subsequent event that hits 
that same asset, will result in the M-kill becoming a K-kill. This is recorded in MTWS as 
–1 M-kills, and +1 K-kills. 
 
The example shown below illustrates this. 
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FIRE MISSIONS 
 
Fire Mission. This report provides information about fire missions. Filtering is available 
for (fire mission) ID, target kind (CE Product, Location, Target, Unit or Airfield), firing 
unit, target name, firing side, firing weapon and projectile (type). 
 
Fire missions that are filtered off in the CART map display are not shown in this report. 
Fire missions that finished before the reporting period, or started after the reporting 
period are also not reported. 
 
The report shows only damage by fire missions that occurred during the report period. 
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Fire Missions Which Caused No Damage. 
 
This report list fire missions which caused no damage (i.e., “no assessment”).  
 
Fire missions that are filtered off in the CART map display are not shown in this report. 
Fire missions that finished before the reporting period, or started after the reporting 
period are also not reported. 
 
Fire missions that caused damage outside of the report period are not reported even if 
they caused no damage during the report period. 
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Fratricide. 
 
 This report lists all missions (both air and indirect fire), which inflicted same-side 
casualties. (Note same side ground combat is not possible in MTWS.)  
 
Fire missions and air missions that are filtered off in the CART map display are not 
shown in this report. Fire missions and air missions that finished before the reporting 
period, or started after the reporting period are also not reported. 
 
Fire missions that caused damage outside of the report period are reported even if they 
caused no damage during the report period. 
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GROUND 
 
Ground Unit. 
 
This accesses the Detailed Ground Unit Report. Side, Unit Type, Hierarchy and 
Controller can filter this report. Report fields are name, side, controller, located at, 
hierarchy, unit type, speed, heading, mission, posture, formation, engaged, higher HQ, 
subordinates, combat effectiveness and rollup. 
 
Ground units that are filtered off in the CART map display are not shown in this report. 
Ground units that were created after the reporting period, or deleted before the reporting 
period are not shown. 
 
Ground units that are not visible on the map display, because they are located on another 
simulation object, for instance, on board a ship, or being transported on a ship-to-shore 
element, are included in the ground unit report. All values shown for units are as they 
were at the end of the report period.  

  
The “rollup” reports the combat effectiveness for the unit and all of the units 
subordinates. The rollup is calculated by summing the combat power of all subordinate 
units, (and the subordinate’s subordinates etc) and dividing this value by the initial 
combat power of the unit and all the subordinates. 
 
By contrast the “subordinates” field shows only the unit’s immediate subordinates.  
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Clicking on the unit name in the Detailed Ground Unit Report brings up the Situation 
Report on that unit (see below). 
 

 
 
The situation report shows all available information for the given unit. Values shown are 
correct for the time at the end of the report period. Using “Other Reports Available” the 
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Unit Readiness, Unit Rollup and Asset History reports on that specific unit can be called-
up. 
 
The last update shows the date that any item of data was last changed by the simulation 
system during the reporting period. 
 
The situation report is also used for displaying information on ships and is accessed from 
the Maritime, Ships report (see the information on the Ships report which is described 
below). 
 
Unit Readiness Report 
 

 
 
The Unit Readiness report is selected directly from the unit Situation Report. It reports all 
the assets and personnel controlled by the given unit, at the time at the end of the report 
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period. The value shown as the initial value is defined at the start of the exercise, or if the 
Unit is created during the exercise it is the value when the unit is initialized through the 
Command Entry window on Maui. 
 
Unit Rollup 
 
The Unit Rollup report is available from the unit Situation Report. The Unit Rollup report 
shows a variation of the Unit Readiness report, showing the assets controlled by unit and 
all of its subordinates. 
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Asset History 
 
The Asset History report is selected from the unit Situation Report. It shows the changes 
to the assets and personnel of the unit, over the report period. 
 

 
 
The above report shows the unit 4AG, which was hit by 7 Maverick missiles at 8:14 (this 
information would be available from the CDA report). The damage is shown with losses 
or damage of 6 T-64s and associated personnel losses and destruction of ammunition. 
The damage calculated by the simulation is shown with a rationale of “Attrition”. Note 
that the figures shown are not adjustments to the totals of assets as they are in the CDA 
report. The final line of the Equipment history table should be read as saying that at 0814 
the unit has 0 operational T-64s, 3 M-kills, 2 F-kills, and 1-K-kill. 
 
The rationale “simulation” shown for the fuel indicates the use of fuel for moving assets. 
“Simulation” is also used to indicate the consumption of water and rations and the use of 
ammunition. 
 
Transfers when shown include the source (if being received) or destination (if being 
transferred out) and if used, the cargo. 
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Note that users using command entry assign rationales and comments when entering asset 
update commands and asset allocate commands. Available rationales include Air_Adj, 
Fire_Adj, Ground_Adj, Other_Adj, Airlift, Attrition, Initial, Magic, Maintenance, 
Medevac, Merge, Resupply, Simulation, Split, Transfer. 
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INTELLIGENCE 
 
Air Recon. 
 
This report lists the detections acquired by air recon missions. 
 
Air missions that are filtered off in the CART map display are not shown in this report. 
Air missions that landed (or were destroyed) before the reporting period, or took off after 
the reporting period are also not reported. 
 
This report shows all intelligence information gathered by the displayed air mission, 
including information gathered outside the report period. 
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Ground Detections. 
 
The Ground Detections Report reports the ground detections and can be filtered by 
detecting unit, detecting side, detected unit, detected side and method of detection (e.g., 
GSR, GES, visual). The report fields are (time) gained, (time) lost, location, detecting 
unit, detected unit, detection method, distance, direction, detectee perceived combat 
power, RDF detection quality, aural detection quality and assets (detected). 
 
Ground Detections that are filtered off in the CART map display are not shown in this 
report. Ground Detections that were lost before the reporting period, or were gained after 
the reporting period are also not reported. 
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Intelligence Collection. 
 
This is a report of the defined intelligence collection areas and fields. The full sets of 
items reported by this report are ground sensors (GES), ground surveillance radars 
(GSR), counter fire radars (CFR) and search radars (PAR). Note that what is reported is 
the presence of a radar area or active sensor field, and not the actual presence of assets. 
To identify the location of all intelligence assets the Assets report should be used (see the 
next section). 
 
This report can be filtered by ID, operator, class and (sensor) type. Report fields are ID, 
operator, location, class, type, status and range. 
 
Reporting of intelligence collection assets are not affected by the filters from the CART 
Map Window.  
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LOGISTICS AND COMBAT SUPPORT 
 
Assets. 
 
This brings up a list of all assets in the exercise database. Clicking on an asset in the list 
creates a report that lists all units possessing that asset and the quantity possessed. 
Clicking on a unit in this report will output the Unit Readiness Report for that unit.  
 

 
 

 
 
Cargos 



The MTWS Documentation Suite – Volume 5 
MTWS Exercise Analysis 

 

62 

 
This report lists the cargos defined in the database and can be filtered by supplying and 
destination unit. The report fields are Cargo ID, (creation) DTG, Supplying Unit, 
Destination Unit and contents. 
 
The CART map filters do not affect the Cargos Report. Cargos that were delivered before 
the reporting period, or were created after the reporting period are not reported. Cargos 
that were delivered during the reporting period are typically shown with an empty 
contents list, reflecting the fact that the assets are controlled by the unit and not the 
Cargo. 
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MARITIME 
 
Clear Path 
 
This report lists the cleared paths through maritime minefields (i.e., anti-ship). Name 
and/or side may filter this report. As shown below the fields available are: name, side, 
vertex locations, width, ship or ships assigned to clear the path, status of the clearing 
operation (i.e., the operation is complete or not) and the percent complete. 
 
Clear Paths not shown on the CART Map Window are not shown in the report. 
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Maritime Minefield 
 
This report lists the maritime minefields (i.e., anti-ship), which are in the exercise 
database. Minefield ID and/or side can filter the report. The fields available are: name, 
side, vertex locations, minefield type, ship(s) assigned, operational status and percent 
complete. 
 
Minefields that are not visible in the CART map window are not included in the report. 
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Patrol Area. 
 
This report lists the maritime patrol areas. Name and/or side may filter the report. Name 
Side, Vertex Locations, and Monitoring Entity are reported. 
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Sonar Track. 
 
This report lists the sonar tracks acquired by the various maritime objects (i.e., ships, 
submarines and ASW air missions). Side and/or detector name may filter the report. The 
fields available are: track ID, detectee side, detectee name, detector side, detector name, 
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detectee location, detectee speed, depth band, depth, range from detection, bearing from 
detection and time of detection. 
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Ships. 
 
This report lists the ships, which are defined in the exercise database. The report can be 
filtered by name (ship ID), side and/or controller. The fields available are: name, side, 
controller (ID), located at (i.e., location of ship), speed, heading, mission (type), higher 
HQ, subordinates, combat effectiveness and rollup. 
 

 
 
Ships that are filtered off in the CART map display are not shown in this report. Ships 
that were created after the reporting period, or deleted before the reporting period are not 
shown. 
 
All values shown for ships are as they were at the end of the report period.  
 
The “rollup” reports the combat effectiveness for the ship and all of the ship’s 
subordinates. The rollup is calculated by summing the combat power of all subordinate 
ships and units, (and the subordinate’s subordinates etc) and dividing this value by the 
initial combat power of the ship and all the subordinates. 
 
By contrast the “subordinates” field shows only the ship’s immediate subordinates.  
 
Clicking on the unit name in the Ships Report brings up the Situation Report on that unit 
(see section “Ground Unit Report”) and this provides access to the Asset Histort, Unit 
Readiness, and Unit Rollup reports. 
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Submarine. 
 
This report lists the submarines, which are defined in the exercise database. Sub ID 
and/or side can filter the report. Fields available are Name, Side, Location, Speed, Depth 
Band, Depth and Heading. Clicking on the name of the submarine brings up the 
Submarine Asset Report (which shows the assets controlled by the submarine, using the 
same format as the Unit Readiness report. 
 
Submarines that are filtered off in the CART map display are not shown in this report. 
Submarines that were created after the reporting period, or deleted before the reporting 
period are not shown. 
 
All values shown for submarines are as they were at the end of the report period.  
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SHIP-TO-SHORE 
 
Element. 
 
This provides a report of ship-to-shore elements defined in the database. This report can 
be filtered by element type, landing means (air and/or surface) and the transporting asset. 
Valid report fields are element ID, element type, landing time, LOD time, serial ID, 
landing means, destination, transport asset and the number of landing craft/aircraft. 
 

 
 
Display of elements in this report are not affected by the CART Map Window filters. 
Clicking on a serial id will show the serial contents. Clicking on the destination will show 
the beach information (locations of beach, rendezvous point, LOD, and transport area) or 
landing zone information (side, location, and type)  
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Landing Craft. 
 
This report lists the landing craft availability over the report period broken down by 
landing craft type and shown by beach and by total for all beaches. 
 
Results shown in the Landing Craft Availability report are not affected by the CART 
filters. 
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Serial. 
 
Provides a report of all serials defined in the database. Serial ID, side and landing means, 
can filter this report. Report fields are Serial, side, landing means, contents type and 
contents name. 
 
The contents of the Serials Report are not affected by the filter settings or report period 
settings in the CART Map Window. 
 
Clicking on the serial name shows the serial contents, including a breakdown of any 
cargo contents contained in the serial. Clicking on the contents name shows the Unit 
Readiness report, or Cargo Assets Report (which shows the cargo’s assets in the same 
format as the Unit Readiness report). 



The MTWS Documentation Suite – Volume 5 
MTWS Exercise Analysis 

 

74 
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Spot Reports. 
 
Spot Reports 
 
This report provides access to all the spot reports generated by MTWS while the CART 
Server is connected. Message type, unit or mission and controller can filter the report. 
Message type, unit or mission, UTM, DTG, Controller, and Message are reported. 
 
No action is necessary to enable particular controllers in CART. The spot reports can be 
used to show information on aspects of the simulation not currently supported by, for 
instance, creation or destruction of structures or other CE products, or environmental 
aspects such as NBC contamination areas, weather zones etc. 
 
Spot reports can also be used to summarize related events, for instance selecting the 
mission id for an air mission shows the entire life cycle of the air mission, including any 
engagements entered into, damage sustained, and results of air mission including air or 
surface tracks detected, assets destroyed etc. 
 
As the handling of the spot reports in CART is very different from all other information, 
the Spot Reports report also can be used to validate the results gained from CART. The 
spot reports show the exact same information sent to the users and, thus presents the same 
truth that was available during the simulation. If a situation arises were the results of the 
after action analysis are disputed, the spot reports can be used to determine whether the 
problem exists in CART, the simulation, or the users’ recollections. 
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EXERCISE SUMMARIES 
 
Combat Power Over Time 
 
This provides a listing of total combat power and combat effectiveness by side over the 
selected time period, reporting a single line for times that are separated by a given time 
period. By default the report assigns a time interval to generate a report that shows 
approximately 20 entries. The time period may be set by entering a number into the text 
box, and selecting a unit type (minutes, hours, days) and then pressing “GO”. 
 
The combat power over time is not affected by the filter settings on the CART map 
window. 
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Combat Power Snapshot 
 
This provides a listing of all units and their combat power and combat effectiveness for 
all non-filtered units. At the bottom of a report is the aggregate combat power and combat 
effectiveness for the reported units. 
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Exercise Status. This provides the status of the CART Server and if there is a current 
exercise, key information about the current exercise. 
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CART DATA TRANSFER TO MICROSOFT PRODUCTS 

CART DATA TRANSFER 
To Excel Spreadsheets 
 
CART provides the capability to export numerical ranges within a report matrix to an 
Excel spreadsheet for charting purposes. 
 
Select any CART report. 
 

 
 
Left click on the mouse and drag the cursor across the report data. Notice that the data is 
now highlighted. Select Ctrl-C and copy the data. 
 

NAME TARGET WEAPON PROJECTILE ROUNDS 
FM-2DDG 11SMS533919 5/54-NAV-GUN 5IN-HE 20 
FM-B11-1 11SMS540901 M-198 155MM-CLGP 1 
FM-A11-1 11SMS560911 M-198 155MM-HE 32 
NAME TARGET WEAPON PROJECTILE ROUNDS 
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Left click on the Start icon, left click on Programs and open Microsoft Excel. Select Ctrl 
V and paste the data to the spreadsheet. 
 

Name Target Weapon Projectile Rounds 

FM-
2DDG 

11SMS533919 5/54-
NAV-
GUN 

5IN-HE 20

FM-
B11-1 

11SMS540901 M-198 155MM-
CLGP 

1

FM-
A11-1 

11SMS560911 M-198 155MM-
HE 

32

Name Target Weapon Projectile Rounds 

To Microsoft Word 
 

CART SCREEN CAPTURES AND TRANSFER  
 
Since the CART client operates on a pc workstation using Windows 2000 for an O/S 
normal screen displays can be captured and inserted directly to Microsoft PowerPoint and 
Microsoft Word. 
 
To: PowerPoint  
 
Select the CART Tactical Display. Press the “Print Screen/SysRq” button on the 
keyboard to capture the whole screen, or Alt-Print Screen to capture the currently 
selected window. Left click on the Start icon, left click on Programs and open Microsoft 
PowerPoint. Select a new slide. Select Ctrl V and paste the CART Tactical Display to the 
new slide. 
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To: Word 
 
Select the CART Report Generator. Press the “Print Screen/SysRq” button on the 
keyboard. Left click on the Start icon, left click on Programs and open Microsoft Word. 
Select Ctrl V and paste the CART Report Generator to the new document. 
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